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RELEASE NOTES 

 

The following documents changes/corrections to the program with each Version Release.  The 

latest release incorporates all changes listed. 

 

MGSFlood Version 4.58 – June 16, 2022 
❖ Included routine that allows separate climate (precipitation and evaporation) time series to be defined for 

the pre- and Post-developed scenarios. This was requested by SPU so that climate change scenarios can be 

compared. 

❖ Feature is disabled unless the MGSRegions.mdb database with the SPU climate change time series is being 

used. 

❖ Suppressed error message when computing water quality flow rate for links downstream of detention 

facilities. This message appeared repeatedly before and is of limited use to the user. 

❖ Corrected Ecology Bioretention Routine stability computation which caused unrealistic routing when very 

small facilities were simulated. 

 

MGSFlood Version 4.57 – November 1, 2021 
❖ Corrected graph loading routine that would cause the program to hang when opening some projects. 

 

MGSFlood Version 4.56 – October 4, 2021 

❖ MGSFlood now fully approved by Department of Ecology, including bioretention routine 

https://fortress.wa.gov/ecy/ezshare/wq/Permits/Flare/2019SWMMWW/2019SWMMWW.ht

m#Topics/AdditionalResources/AppStatusOfContSimMod.htm?TocPath=Additional%2520

Resources%257C_____4 
❖ Implemented Default HSPF parameters from Ecology WWHM that includes slope groups. These are the 

default when MGSFlood starts and are labeled “Ecology Default” on the parameter Screen accessed from 

the Tools tab. The original MGSFlood default parameters are labeled “USGS Default”. Projects created 

prior to this release continue to use the original default parameters when opened in this release.  

❖ Included WSEL frequency statistics for infiltration trenches 

❖ Corrected WSEL frequency plotting routine so that the drop-down list box populates then the graph type 

switches. 

❖ Added button to subbasin screen that toggles on/off rows with zero area. 

❖ Water quality flow rates are automatically computed along with the water quality volume for the points of 

compliance at the end each simulation. 

❖ Corrected routine to document in the project report when default runoff components are changed for the 

PERLNDS.  

❖ Changed installation directory to folder: C:\Users\<User Name>\AppData\Local\ rather than 

Programs x86 folder. Reduces potential for read/write problems because of additional permissions required 

by Windows 10. 

 

MGSFlood Version 4.55 – June 1, 2021 
❖ Corrected the placement of the Ecology Bioretention underdrain in the biosoil. When the offset was set to 

0, the underdrain was being placed too low in the soil column, below the storage allocated for soil moisture 

wetting resulting in overestimation of flow through underdrain. 

❖ Correct error in water quality calculation routine for CAVFS. Error was introduced in previous version 

when CAVS calculation routine was updated. 

 

MGSFlood Version 4.54 – January 4, 2021  

https://fortress.wa.gov/ecy/ezshare/wq/Permits/Flare/2019SWMMWW/2019SWMMWW.htm#Topics/AdditionalResources/AppStatusOfContSimMod.htm?TocPath=Additional%2520Resources%257C_____4
https://fortress.wa.gov/ecy/ezshare/wq/Permits/Flare/2019SWMMWW/2019SWMMWW.htm#Topics/AdditionalResources/AppStatusOfContSimMod.htm?TocPath=Additional%2520Resources%257C_____4
https://fortress.wa.gov/ecy/ezshare/wq/Permits/Flare/2019SWMMWW/2019SWMMWW.htm#Topics/AdditionalResources/AppStatusOfContSimMod.htm?TocPath=Additional%2520Resources%257C_____4


7326 Boston Harbor Road NE 

Olympia, WA  98506 

(253) 841-1573 

 www.MGSengr.com 
 

 

Page 2 

 

❖ Corrected Water Quality treatment summary stats for new Ecology bioretention element. Filtered runoff 

refers to runoff passed through a filter media and picked up by the underdrain. Infiltrated runoff is runoff 

that infiltrates to the native soil and is lost from the system. The sum of these is the treatment for the 

facility. 

❖ An error in the Ecology bioretention routing routine was corrected where underdrain flows were not being 

passed to downstream links connected to the bioretention link.  

❖ Revised the Ecology bioretention graphic accessed from the input screen so that the floor elevation and 

other definitions agree with MGSFlood input convention. 

❖ Corrected formatting in project report. 

 

MGSFlood Version 4.53 – November 13, 2020  
❖ Added new bioretention Element that meets Ecology 2019 stormwater management manual. 

❖ Added option to display LID duration as 10% and 1% exceedance for SPU pasture duration standard. 

❖ Added ability to open license screen from the File menu. Allows users to update their license file without 

editing the license text file in the program directory. 

❖ Changed Infiltration trench on a slope to include infiltration through the narrow dimension in addition to 

the long dimension.  

❖ Corrected routine for computing infiltration/filtration statistics for links through the Water Quality menu. If 

the time series was not yet decompressed, an error would sometimes occur. 

❖ Set Default Time step to 5 minutes for extended precipitation, 15 minutes for station data. 

 

MGSFlood Version 4.52 – June 11, 2020  
❖ Corrected issue that caused the program to crash on startup when the user had their system date set to yyyy-

mm-dd format rather than mm/dd/yyyy format.  This caused the masked edit boxes for the input dates on 

the graph control to crash.  

❖ Corrected Error on optimizer input screen for trenches and ponds where Massmann checkboxes were 

inactive when screen first opens 

 

MGSFlood Version 4.51 – March 22, 2020  
❖ Included option for user to turn on Massmann biofouling and maintenance reductions when user specified 

hydraulic gradient is selected for infiltration. This applies to Ponds, Open Channels, Infiltration Trenches, 

and Filter Strips. 

❖ Included summary of days and months out of compliance for wetland inflow analysis routine in project 

report. Included red highlight for days/months that are out of compliance. 

❖ Corrected formatting in project report for subbasins where various runoff components are turned off, e.g. 

surface, interflow and groundwater 

 

MGSFlood Version 4.50 – June 20, 2019  
❖ Corrected issue with flow splitter input where lower scroll bar arrow was not visible on screen. 

❖ Corrected error that occurred when seasonal stats were computed using Version 4.49. 

❖ Added the ability to compute statistics for subbasins via the right click menu on the watershed layout 

graphic. This ability has been missing for quite some time. 

 

MGSFlood Version 4.49 – May 9, 2019  
❖ Added 15-minute station precipitation data from WWHM 

❖ The Pierce County time series were stored on a 1-hour time step. The Ecology manual requires use of 15-

minute time steps for most design applications. The Pierce County Time Series were assigned to the 

applicable Puget East and Puget West Time series which have been disaggregated to 5 minutes. The Puget 

Time series are valid for use in Pierce County and provides the flexibility to perform designs down to a 5-

minute time step.  
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❖ Modified Massmann Infiltration equations to include option for user-defined hydraulic gradient. If user 

specifies the hydraulic gradient, then infiltration is computed using Darcy’s equation with no reductions 

from the Massmann regression equations.  

❖ Modified Water Quality flow splitter calculator to allow user to specify design flow rate. Previous versions 

used the off-line water quality design flow rate. With this update, the user can include a factor of safety on 

the design flow rate before running the flow splitter calculator.  

❖ Corrected issue with some versions of 4.46 where time step would reset to 1-hour after loading a previously 

saved file. 

 

MGSFlood Version 4.48 – Internal Release 

 

MGSFlood Version 4.47 – Internal Release 
❖ Corrected issue with Light version when program started, the time series in the time series list box was 

correct, but Puget West 32 was selected for analysis until user clicked the time series box. 

❖ Report truncated the thousands digit when the total tributary area exceeded 999 acres. 

❖ Corrected Wetland statistics routine that caused program to crash when run. 

❖ Corrected plotting of hydrographs. Min, Max, Average parameter was not being applied. 

❖ Corrected ET scale factor editing. Form wouldn’t accept changes to the ET factor. 

 

MGSFlood Version 4.46 – January 5, 2018 
❖ Added routine that looks for subbasins with runoff components turned off and alerts user when project is 

being upgraded. Subbasins with runoff components turned off are listed and the user can restore these to 

default values. 

❖ Included table in project report that is displayed when runoff components are different from the default 

values. 

❖ Changed the minimum subbasin area to 0.005 ac in response to users who wished to simulate smaller areas. 

❖ Corrected error trap for subbasins smaller than the minimum. The trap was only looking at the last subbasin 

added. 

❖ Added prompt to save file when user opens another file. The message is similar to the one displayed when 

program exits. 

❖ Upgraded installation program to InstallShield 2016 from InstallShield 2015.  

 

MGSFlood Version 4.45 – December 8, 2017  
❖ Corrected bug in subbasin copy and paste routine. When you copy and paste a subbasin, the runoff 

components for impervious and pervious areas are unchecked in the pasted subbasin. This effectively 

eliminates any runoff from the pervious land segments from the pasted subbasin. This error originated in 

the Version 4.40 release from June of 2016 and is present in Version 4.40 through 4.44. 

 

MGSFlood Version 4.44 – December 6, 2017  
❖ Corrected precipitation scaling bug when Clark County precipitation was selected. The model would 

typically over-scale the rainfall. The precipitation output in the project report was also clarified so that the 

correct scaling factor is displayed  
❖ Corrected bug that prevented precipitation region from being displayed in project report when saved file is 

first opened. 

❖ Modified user's manual to include additional information on the Clark County precipitation scaling method.  

 

MGSFlood Version 4.43 – August 22, 2017  
❖ Corrected bug in infiltration statistics that resulted in divide by zero when structure was a copy link. 

❖ Corrected InfiltrationPondIrregular DLL which could not be called by executable because subroutine name 

was too long. Included 132 column statement at top to correct issue. This corrected a Runtime Error 53 

crash. 
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MGSFlood Version 4.42 – May 10, 2017  
❖ Corrected bug in Open Channel routine where the Right Overbank-Middle Width was switched to the 

middle Side slope when the file was saved and re-opened. 

❖ Corrected glitch that caused the optimizer to crash when running precipitation time series from Thurston 

County. The glitch was caused by MKL spline routine in DischargeRatingCurve routine. All MKL routines 

had been removed except for this one. Routine now uses linear interpolation routine from MGS. 

❖ Revised duration matching criteria labels in report to say the durations 1 and 2 must be less than or equal to 

0. (or equal to added to labels) 

❖ Recompiled all FORTRAN DLL’s  
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MGSFlood Version 4.41 – March 16, 2017 
❖ Modified project report to zero out negligible discharges in the peak discharge tables. 

❖ Modified the percent treated values to correctly report 100% treated when all runoff is infiltrated or filtered. 

❖ Corrected bug for computing time for infiltration facilities to drain. Divide by zero occurred if infiltration 

was zero for lower elevations in facility 

❖ Corrected WSEL frequency plot where program would crash with error 380 code for facilities with depths 

less than 2 feet. 

 

MGSFlood Version 4.40 – June 16, 2016 
❖ Included precipitation time series developed by the Department of Ecology for Thurston and Clark 

Counties 

❖ Added Clark County area specific HSPF parameters. These parameters are selected from the HSPF region 

box on the Tools tab. They are also automatically activated when a Clark County precipitation time series 

is selected. 

❖ Modified the subbasin land use input screens to accommodate a variable number of pervious and 

impervious land use types depending on the runoff parameter region selected. 

❖ Modified the subbasin runoff component screen to accommodate a variable number of pervious land use 

types. 

❖ Replaced the wetland hydroperiod analysis routines with the new wetland flow statistics approach in the 

2014 Ecology Stormwater Manual.  

❖ Modified pervious pavement routine to allow for simulation without check dams for long, sloping 

pavement structures. Added warning message that alerts user when additional check dams could improve 

pervious pavement performance. 

❖ Included ability to plot porous pavement gravel trench water surface elevation-frequency statistics on 

graphics screen and display them in the project report. 

❖ Corrected time series number displayed in the project report. Number shown in report didn’t match the one 

on the drop down list box on the Main page. 

❖ Corrected issue writing to internal database files after structure optimizer is run. This error only occurred 

with Windows 10 operating systems. Correcting this error necessitated turning off the black optimizer 

status screen. It may be reactivated at a later date. 

❖ Recompiled all DLL’s using latest Intel Fortran compiler 

❖ Updated InstallShield routine to 2015 release to eliminate Windows 10 incompatibility. Included C++ 

redistributable module needed for Intel FORTRAN. The C++ redistributable installs prior to the MGSFlood 

installation screen. 

 

MGSFlood Version 4.39 – Internal Release 

 

MGSFlood Version 4.38 – May 21, 2015 
❖ Corrected stability algorithm in routing routine to reduce continuity errors which could be as high as 3 

percent in some rare circumstances. The stability routine was corrected and now the continuity errors are 

within 0.5% 

❖ Included more detailed link inflow, outflow, filtration, and infiltration volume statistics in project report. 

❖ Added watershed area summary to beginning of project report. 

❖ Corrected 25-year WSEL quantile estimate in project report, which was erroneously reporting the 20-year 

recurrence interval. 

❖ Eliminated warning message displayed during simulation when volume in infiltration structure was 

insufficient to compute drawdown time.  

❖ Eliminated warning message displayed when all values were the same which makes computation of 

frequency stats impossible. 

❖ Corrected loading of computed water surface elevation stats from project file. Values were not being 

loaded from file into memory resulting in all zeros being displayed in report. 



7326 Boston Harbor Road NE 

Olympia, WA  98506 

(253) 841-1573 

 www.MGSengr.com 
 

 

Page 6 

 

❖ Corrected erroneous warning message in project report telling user to recompute runoff each time water 

quality stats were computed. 

❖ Corrected CAVFS routine so that surface area does not go to zero when CAVFS is dry. Prevents precip and 

evaporation from being eliminated when CAVFS is empty. 

❖ Modified InstallShield installation to allow Users group to have Full Control over installation directory.  

 

MGSFlood Version 4.37  – February 10, 2015 
❖ Modified Link time series export routine. Exported time series now includes a column called treatment 

flows, which is the sum of filtered and infiltrated water. This is needed for use with SPU HydroStats 

❖ Modified routing routine to include a more accurate estimate of infiltrated moisture when the facility goes 

dry. 

 

MGSFlood Version 4.36  – February 5, 2015 
❖ Corrected when message is displayed in report noting that changes have been made and runoff has not been 

computed. This message is now displayed when changes are made throughout the project input. 

❖ Added the date when input file was last routed in addition to the report creation date at the top of the 

project report. 

 

MGSFlood Version 4.35  – January 29, 2015  
❖ Added new feature that exports peak discharge with antecedent precipitation for a range of durations. 

Included Excel Workbook tools for estimating the likelihood of rainfall forecast by the NWS exceeding 

discharge design rates. 

❖ Corrected the seasonal statistic routines relating to the season start and end dates. In certain cases the output 

annual maxima date labels were off by one year. 

❖ Modified Link/Subbasin export routine to include code to correct for errors in the date/time stamp when 

exporting with 5-minute time steps. This resulted in different statistical results when the exported files were 

imported into HydroStats. 

❖ Updated installation File with InstallShield 2013. 

 

MGSFlood Version 4.34  – February 25, 2014  
❖ Time step dependent parameters in the HSPF PERLND routine were not being correctly updated when time 

steps of 10-minutes or 30-minutes were selected on the Simulate tab. This resulted in an over-estimation of 

peak runoff rates for simulations conducted with these time steps. Other computational time steps, e.g. 5-

minutes, 15-minutes, and 1-hour produced correct results and were unaffected by this correction. 

❖ The hydraulic rating table calculation array for the bioretention routine was increased. Bioretention 

facilities with large depths could exceed the array size causing the program to crash. 

 

MGSFlood Version 4.33  – December 8, 2013 
❖ Bioretention routine was not properly accounting for case where limiting discharge was from biosoil rather 

than native soil. Infiltration from facility can be limited by either the native soil or the bio-soil infiltration 

rate times the area of infiltration. Because the infiltration area of the native soil can be larger than the 

biosoil, a lower native soil infiltration rate can result in the biosoil being the limiting discharge. The 

program now computes the discharge for both biosoil and native soil to determine the limiting layer at each 

stage in the facility. 

❖ The limiting control for bioretention facilities is now output to the project report next to the hydraulic rating 

table. The control can be one of the following: biosoil, underdrain orifice, or native soil. 

❖ Corrected routing stability criterion which was mistakenly shifting routing time step to 1 second for 

infiltration facilities with vertical side slopes where the infiltration rate didn’t change on subsequent 

elevations. This caused long simulation times for these facilities. 
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❖ If infiltration pond is empty and infiltration at bottom exceeds inflow rate, then infiltration flow rate set 

equal to inflow rate. Before, the infiltration at the bottom was being used, which over-stated the volume 

infiltrated. 

❖ Post-developed flow duration curves being plotted in the program lacked resolution at the low end (near the 

LID sizing flows). Additional points were added to the post-developed duration curve to ensure reasonable 

plotting in this area. Comparisons between pre and post developed were being done accurately, only the 

plotting and project report output was affected. 

❖ Changed interpolation from Cubic Spline to Linear for computing 50-year and 100-yr flow and WSEL 

Quantiles. Cubic Spline was producing erroneous values for station data analyses. 

 

MGSFlood Version 4.31  – May 21, 2013  
❖ Modified the bioretention facility routine to allow simulation of vertical side slopes, which is useful for 

planter simulation. New Bioretention schematic shown below. 

❖ Modified water quality discharge routine to so that full arrays were being used. Allows routine to compute 

water quality discharge for sites with little or no impervious surface. 

❖ Changed bioretention facility so that biosoil was truncated on sides based on maximum possible water level 

in pond. The maximum level is determined by the elevation entered by the user. 

❖ Corrects “Runtime Error 9 Subscript Out of Range” Error Message that sometimes occurred with Version 

4.29  

❖ Export Utility was not exporting the total inflow to the link. It was omitting the contribution from 

precipitation and evaporation in the Inflow.  

❖ Corrected Licensing Routine that was incorrectly reading permanent licenses and rejecting valid licenses 

 
Original Schematic 
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Revised Schematic 

 

 

MGSFlood Version 4.29  – February 6, 2013 
❖ Modified routing routine so that it uses shorter routing steps to maintain stability when the structure 

discharge is large relative to the structure volume. 

❖ Corrected volume calculation in bioretention facility. The volume in the biosoil wedge below the pond 

bottom on the ends was not being included in the calculation. 

❖  Settings for default data directory were not being saved in registry. Now corrected. 

❖ Corrected flow duration compare routine that would sometimes show a very small infiltration facility as 

passing the duration standard when in fact it wasn’t. 

 

MGSFlood Version 4.28  – July 26, 2012  
❖ Corrected glitch in User Elevation Volume table where there were multiple structures in a project. If the 

user opened a structure and then closed it again without opening the user volume table, the table would be 

overwritten by table from another structure. 

❖ Corrected bug in seasonal duration that was triggered when seasonal stats were computed and compute 

stats for all subbasins and links was selected. Identified by Alex Nguyen on July 12, 2012. 

❖ Corrected the volume reported in the report which mistakenly added biosoil volume to the total. 

❖ Added user-defined database MGSUserData.mdb, which allows project-specific precipitation and 

evaporation data to be used in the model. This is useful for model calibration purposes 

❖ Changed CAVFS routine so that thickness of compost soil is no longer included in gradient calculation. A 

constant gradient equal to the slope of the CAVFS is now used. 

 

MGSFlood Version 4.27  – May 21, 2012  
❖ Added routine, interface, and reporting for seasonal flood-frequency and duration analysis. Up to 12 

separate seasons can be performed in a project file. 

 

MGSFlood Version 4.26  – May 1, 2012  
❖ Corrected hydrograph export utility that was sometimes not exporting hydrographs from links. This is the 

utility that exports hydrographs of a given duration with frequencies of 2-years through 100-years. 

❖ Included checks for new Ecology LID Standard. 

❖ Clarified schematic on bioretention input screen 

❖ Removed start up directory from registry.  

❖ Included new license validation routine. 
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MGSFlood Version 4.12  – March 27, 2011  
❖ Routing Routine was not stopping when routing flows for structures that were grossly undersized relative to 

the inflows passing to them.  A line in the code that checked for small changes in storage was causing the 

program to miss the error flag used to terminate when the rating table is extrapolated.  An additional error 

flag was inserted to terminate the program when this occurs. 

❖ The constant infiltration option wasn’t being utilized in initial infiltration pond sizing and resulted in 

oversized infiltration ponds in the optimizer. 

❖ When specifying the pond geometry in the structure input screen and project report, a Runtime Error 9, 

subscript out of range error could occur if the max pond elevation is considerably higher than the riser crest 

elevation.  

❖ When stats were computed for all links during a simulation, the program would produce an Error 5 

message if there was a structure in the predeveloped condition.  The scenario number wasn’t being passed 

to the WQ routine, now corrected. 

 

MGSFlood Version 4.09  
❖ Precipitation scaling was not being performed correctly for projects that utilize precipitation station data.  

In many cases a scaling factor of 1.00 was being applied instead of the ratio of the site to station 25-year, 

24-hour rainfall.  This did not affect any projects that utilize the extended precipitation time series.  

❖ Water surface elevation stats were not being computed for bio-retention facilities where the water level did 

not pond on the surface of the bio-soil.  

❖ User defined HSPF parameters were not being implemented in the model or printed in the project report.   

❖ The label for soil infiltration was changed from saturated hydraulic conductivity to infiltration rate on the 

bio-retention soil structure. 

❖ Corrected flags that require runoff to be recomputed when station scaling factor is changed or when the 

HSPF default parameters are altered. 

❖ The project report is automatically refreshed when the report screen is open and the user clicks the show 

report button on the tool bar. 

 

Version 4.08 
❖ Water quality flow rate calculations were corrected for simulations where a 15-minute time step was 

used.  Previous versions underestimated the water quality rate when computed using a 15-minue time step, 

❖ Reporting of water quality discharge rates was absent unless other water quality parameters were 

computed, this has been corrected, 

❖ The Hydrograph plotting routine would crash when plotting at time steps less than 1-hour for certain date 

ranges, 

❖ Drag and drop icons were not placed properly on the screen of the graphical interface when scroll bars were 

visible, 

❖ A message was added warning users that the secondary outlet to a flow splitter must be connected to 

another reach before routing, 

❖ The porous pavement hydraulic conductivity was labeled as infiltration rate to avoid confusion with the 

hydraulic conductivity specified in the Massmann method used in other links 

 

Version 4.07 
❖ Updated Routing Routine, 

❖ Updated bioretention routine to include storage in soil 

❖ Added pervious pavement routine 

❖ Modified FlowDurationComp to better handle infiltration facilities 

❖ Modified optimizer to include new RoutePuls and FlowDurationComp,  

❖ New license file that sets program to read one timeseries (light version) or standard version. 
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Version 4.06 
❖ Program would crash after optimizing if there were links connected to the optimized link downstream.   

❖ Project report was corrected so that user defined rating tables would be displayed correctly.   

❖ Corrected infiltration trench form, which would incorrectly display infiltration rate after closing form. 

 

Version 4.05 
❖ Corrected water surface elevation-frequency statistics output in project report, which was producing 

erroneous results. 

 

Version 4.04 
❖ Corrected several graphical interface errors relating to setting point of compliance and optimization toggle. 

❖ Corrected number of hydrograph ordinates that can be plot.  If more than 32000 points selected to plot then 

an overflow error (GS Server error) would occur. 

 

 


